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About this Document 
This document is about the features and functionality of Trading Terminal through which a user can 

place orders and view current market stats in real time. It intends to guide the user of the 

application about all views and windows available so that he/she can use it effectively. The 

document discusses different types of views available in the application as well as different 
customization options to customize these views according to user preferences. 

Audience 
As this document is all about the features and usage of online trading terminal, it is intended for all 
users of Online Trading. 

 

 

 

Conventions 
 

CONVENTION / STYLE Purpose 

Bold Name of application objects, e.g. menus, screens, buttons etc. 

 
  

BMA Capital Management Limited



 Trading Terminal v2.0.2_15 2012 
 

 9 

 

Introduction 
 

Trading Terminal is an online trading application that offers the ability to buy and sell shares and 

view real time stock information. Trading Terminal client is installed on the system. This client gets 
connected with the Trading Server. Trading Server has different components running. A main 

component is Message Server which is connected with a Trading Engine. Trading Engine is 

responsible for executing trades. Other server side components are Feed Server, Feed Reader, 

SubFeed Server, FIXGateway etc. These components are responsible for various server side 

operations. This manual covers client portion of the Terminal only. This Terminal (client) offers a 

variety of different useful menu options to facilitate sale/purchase and manage client information 

efficiently. 

Trading Terminal provides following advanced features: 

Different perspectives named Banking, Charts, Research, Social and Trading are available which 

provide user interface for different views and operations. 

All basic views and operations are available in Trading Perspective. In this perspective current 
market statistics for different stocks are available. This perspective also provides exchange metrics 
through a number of watch lists e.g. New Watch List, Index Watch List, Market Watch List and 

PMEX or NCEL watch list etc. Order book and Trade log views are maintained which keep record of 
all pending orders and executed trades respectively. A file is also maintained keeping record of all of 
the current day trades. Buy, Sell, Take, Hit orders can be placed and user can also modify/cancel 
his/her pending orders. Client margin is checked in real time during order entry, taking into account 
the client’s executed trades and pending orders. Client can view his/her current clearing and overall 
portfolio positions. 

Charts perspective provides different stocks and exchange statistics. Advanced charting module is 
provided containing Symbol and Index graphs. 

All of the views can be customized according to user preferences and the customizations persist 
even after exit from the application and are restored on start up. 

  

BMA Capital Management Limited



 Trading Terminal v2.0.2_15 2012 
 

 10 

 

Application Screens 
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•1.2-Application Startup 
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•1.3.1-New Wizard > New 
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•1.3.2-Export 
•1.4-Watch Lists Menu 
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•2.1.4-Trades Summary 
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•2.1.8-Cancel Order 
•2.1.9-Fund Movement 
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s •3.1-Reports Menu 
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•3.1.2-Customer Payment 
•3.1.3-Net Share Custody 

•3.1.4-Outstanding Orders 
•3.1.5-Periodic Summary 

•3.1.6-Periodic Detail 
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1 Definitional 
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Getting Started: 
Navigation: 

Start Menu > Programs > BMA Trading Terminal > Trading Terminal.lnk 

By default, Trading Terminal is installed in Start Menu > Programs > BMA Trading Terminal folder 
of start menu. Start Menu > Programs > BMA Trading Terminal  > config.ini file contains some 

configuration parameters that are appropriate when application is installed. These can be modified 

later if required. 

On start up, Terminal gets connected with the Trading Server. In case, if it fails to connect with the 

Server, following message appears. The connection may fail due to having temporary Server 
shutdown or some communication channel failures.  

 

 

Figure 1: Connection Failed 

1.1 Login  

1.1.1 Login – Login Window 
Navigation:  

Start Menu > Programs > BMA Trading Terminal > Trading Terminal.lnk 

Each application user is provided with a unique user name and password. Each user has a particular 
user type that determines the level of access a user has to the application. There are three types of 
users: 

Trader has full access to all of the views (except Portfolio View) and can place orders on behalf of 
different clients associated with the trader. 

Client also has full access to all of the views (including Portfolio View) but can place orders on behalf 
of him/her only. 

Subscriber has limited access to the application. Order related views and functionality is not 
available for this type of user while all other views are available. 

For application login, 
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1.2 Application Startup 
Navigation: 

Start Menu > Programs > BMA Trading Terminal > Trading Terminal.lnk 

Give valid user id and password. On successful logon this screen is displayed. 

 

Figure 4: Terminal screen on successful logon 
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1.2.1 Application Startup – Perspective Selection 
Navigation: 

Start Menu > Programs > BMA Trading Terminal > Trading Terminal.lnk 

Give user id and password. On successful logon, terminal screen appears. 

Click on the icon encircled in red in the figure 4, select Other and the select Trading Perspective 

from the popup window. 

 

 

Figure 5: Selecting Trading Perspective 
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Application Startup – Perspective Selection (cont.) 

 

Following screen appears. 

 

Figure 5: Trading Perspective 
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1.3 File Menu 

1.3.1 File Menu - New Wizard – New Watch List 
Navigation: 

File > New Wizard > New Watch List 

 

Figure 6: New Watch List Wizard 
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File Menu - New Wizard – New Watch List (cont.) 

 

 

Figure 7: New Watch List Wizard – Name and Currency 

Screen Explanation 

 

Field Function 

Name Name of the Watch List 
Currency Currency to be used in the Watch List 
Use default currency for 
security checkbox 

Check this checkbox to use the default currency of the security. 
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File Menu - New Wizard – New Watch List (cont.) 

Select the column(s) from the Available columns and press the arrow key encircled in the figure. 

You can also press the button below the encircled button to select all columns. You can also re-
order the shown columns by pressing the buttons after shown column list. 

 

Figure 8: New Watch List Wizard – Selecting Columns 

Screen Explanation 

 

Field Function 

Available columns Columns to be selected. 
Shown columns Selected columns to be displayed with the securities in the Watch List 
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File Menu - New Wizard – New Watch List (cont.) 

 

Screen mentioned in the figure 9 appears. Select the security(ies) from the available list of securities 

and press the arrow button encircled in red. You can also re-order the securities by pressing up and 

down button displayed on the right of shown securities list. 

 

 

Figure 9: New Watch List Wizard – Selecting Symbols 

 

Screen Explanation 

 

Field Function 

Available securities Securities to be selected. 
Shown securities Select securities to be displayed in the Watch List. 

 

Press Finish button after selecting the securities. Screen mentioned in the next figure appears. 
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File Menu - New Wizard – New Watch List (cont.) 

 

 

Figure 10: My Watch List 
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1.3.2 File Menu – Export 
Navigation: 

File > Export 

This option exports the chart data or Trade log on to a specified file. 

Following popup dialog appears. 

 

Figure 11: Export Dialog 

To export charts data click on Charts Data in the dialog. Click next. 

 

 

 

 

BMA Capital Management Limited



 Trading Terminal v2.0.2_15 2012 
 

 23 

 

File Menu – Export (cont.) 

 

Following screen appears 

 

Figure 12: Export Dialog 

Click on “Export all” combo box to export all securities. To export a selected list of securities, select 
“Select the securities to export”.  Highlight the securities to export. For historical prices select 
“Historical prices” combo, whereas select “Intraday prices” to select intraday price, whereas select 
“Last prices” to select last prices. Click browse specify location and give the filename. Click finish. 
Open the exported file to check the data. 
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File Menu – Export (cont.) 

 

To export Trade Log select “Trade Log” from the export dialog. Click Next. 

 

Figure 13: Export Dialog 
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File Menu – Export (cont.) 

 

Following screen appears.  

 

Figure 14: Export Dialog 

Select “Export All” encircled in red to export all securities. Whereas to export selected orders select 
“Select the orders to export”. Highlight the orders to export. Select option to export data i.e. “Client 
Wise” or “Symbol Wise”. Click on browse and give the filename. Click finish to export the log. 
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1.4 Watch Lists Menu 
Most of the Watch Lists are stock feed based and have similar customization options. User can 

choose symbols to be shown in the Watch List. User can select different columns to be shown on 

the Watch List from a list of columns and can also arrange these columns in some desired order. 
User’s current settings for different view attributes, layout and positioning are saved on application 

exit and persist even after application has been closed. These settings are restored next time 

application is started. 

 

Figure 15: Watch Lists Menu 

1.4.1 Watch Lists Menu – New Watch List 
Navigation: 

Watch Lists Menu > New Watch List 

 

New watch list is same as File > New Wizard > New Watch List. For details refer to File Menu - New 

Wizard – New Watch List. Details are explained in 1.3.1. 
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1.4.2 Watch Lists Menu – Index Watch List 
Navigation: 

Watch Lists Menu > Index Watch List 

Drag and drop securities from the Market Watch List onto the Watch List.  

 

Figure 16: Index Watch List 

Indexed values are displayed with the securities along with the change percentage. 

1.4.3 Watch Lists Menu – Market Watch List 
Navigation: 

Watch Lists Menu > Market Watch List 

Drag and drop the securities from the Securities view onto the Market Watch List. 

 

Figure 17: Market Watch List 

Details are displayed on the Market Watch List. 
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1.5 Views Menu 

1.5.1 Views Menu - Spot Symbols View 
Navigation: 

Views > Spot Symbols 

Spotted symbols are displayed in this view. 

 

Figure 18: Spot Symbols View 

Screen Explanation 

 

Field Function 

Date Date on which symbols are spotted 
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1.5.2 Views Menu – Locked Symbol View 
Navigation: 

Views > Locked Symbols 

Locked Symbols View displays upper and lower locked symbols. 

 

Figure 19: Locked Symbols View 
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1.5.2 Views Menu – Announcements 
Navigation: 

Views > Announcements 

Announcements view displays announcements for the user logged in. 

 

Figure 20: Announcements View 

Double click the announcement to view it. 
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1.6 Utilities Menu 

1.6.1 Utilities Menu – Quote Request 
Navigation: 

Utilities > Quote Request 

or 

Securities View > Right Click Symbol > Quote Request 

Quote Request displays the quotes for the selected symbol. It includes exchange, symbol, market, 
description, open price, last trade price, change, yest trade, high, low, total trades, turnover, market 
value, volume, from date, to date, spot, order limits and buy and sell. 

 

Figure 21: Quote Request 
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1.6.2 Utilities Menu – Securities 
Navigation: 

Utilities > Securities 

Securities view displays the list of securities in the stock exchange. In this view symbol, exchange, 
market, description and currency and displayed. Select the security(ies), drag it and drop it onto the 

Watch List to see the detailed statistics. 

 

Figure 22: Securities View 

Screen Explanation 

 

Field Function 

Symbol Search Type security symbol to search in the list of securities. 
Description Search Type the security description (name) to search in the list of securities. 
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1.6.3 Utilities Menu – Market Summary 
Navigation: 

Utilities > Market Summary 

Market Summary view displays top gainers, top loser and volume gainers of the market.  

 

Figure 23: Market Summary 

Screen Explanation 

 

Field / Tab Function 

Top Gainers tab It shows top gaining securities in the market. 
Top Losers tab It shows top losing securities in the market. 
Volume Leaders tab It shows leading volume securities in the market. 
 

1.6.4 Utilities Menu – Events 
Navigation: 

Utilities > Events 

Events view displays event details as they occur. 

 

Figure 19: Events 

BMA Capital Management Limited



 Trading Terminal v2.0.2_15 2012 
 

 34 

 

1.6.5 Utilities Menu – Currencies 
Navigation: 

Utilities > Currencies 

Currencies view displays list of currencies available in the market. 

 

Figure 24: Currencies 

1.6.6 Utilities – Web Browser 
Navigation: 

Utilities > Web Browser 

Web Brower provides a browser view which allows browsing inside the view. 

 

Figure 25: Web Browser 
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1.6.7 Utilities Menu – News 
Navigation: 

Utilities > News 

Subscribe to RSS feed by going to Windows > Preferences > News > RSS News. Click Add button and 

add the URL.  

 

Figure 26: News Preferences 

 

Screen Explanation 

 

Field Function 

Source Specify the name of the source. 
URL Specify the URL of the source. 
Automatic Update Automatic update time interval in minutes. 
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Utilities Menu – News (cont.) 

 

News will be displayed in the News View. 

 

Figure 27: News 
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1.7 Window Menu 

1.7.1 Window Menu – Open New Window 
Navigation: 

Window > Open New Window 

Open New Window opens a new Window of the terminal. 

 

Figure 28: Open New Window 
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1.7.2 Window Menu – Open Perspective 
Navigation: 

Window > Open Perspective > Other  

 

 

Figure 29: Open Perspective 

 

To open a new perspective, select other in Open Perspective.  
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 Window Menu – Open Perspective (cont.) 

Following popup dialog appears. 

 

Figure 30: Open Perspective Dialog 

Select the perspective to open. Perspective is opened. 

 

Figure 31: Charts Perspective 
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1.7.3 Window Menu – Customize Perspective 
Navigation: 

Window > Customize Perspective 

Perspective can be customized with toolbar visibility, menu visibility, command groups availability 

and shortcuts. 

Click on the toolbar visibility tab to customize the toolbar. Following window appears. 

 

Figure 32: Tool Bar Visibility 

Screen Explanation 

 

Checkbox Function 

New  New appears on the toolbar 
Save (Ctrl +S)  Save option appears on the toolbar 
Save All(Ctrl +Shift +S)  Save All option appears on the toolbar 
Print (Ctrl + P)  Print option appears in the toolbar as well as on appropriate places 
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Window Menu – Customize Perspective (cont.) 

 

Checkbox Function 

Line  Line tool appears in the charts perspective 

FiboLine  FiboLine tool appears in the charts perspective 

FanLine  FanLine tool appears in the charts perspective 

FiboArc  FiboArd tool appears in the charts perspective 

Zoom In  Zooms in 

Normat Size  Display normal zoom 

Zoom Out  Zooms out 
Start News Feed Starts news feed 

Stop News Feed  Stops news feed 

Start quote feed  Starts quote feed 

Take a quote snapshot  Takes a quote snapshot 
Stop quote feed  Stops quote 

Filter by command group Filters by command group 
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Window Menu – Customize Perspective (cont.) 

 

Click on the Menu Visibility tab to customize the Menu Bar. Following window appears. 

 

 

Figure 33: Menu Visibility 

  

BMA Capital Management Limited



 Trading Terminal v2.0.2_15 2012 
 

 43 

 

Window Menu – Customize Perspective (cont.) 

 

Appropriate menu appears on the menu bar on checking appropriate menu items in the menu 

visibility. Different menu items are represented in this section. 

 

Figure 34: Menu Visibility - File Menu 

Screen Explanation 

Checkbox Function 

File Menu 

New Wizard Displays New Watch List Wizard menu 

Close Displays Close menu 

Close All Displays Close All menu 

Save Displays Save menu 

Save As Displays Save As menu 

Save All Displays Save All menu 

Print Displays Print menu and appropriate print options 
Import Displays Import menu 

Export Displays Export menu 

Properties Displays properties menu 

Exit Displays Exit menu 
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Window Menu – Customize Perspective (cont.) 

 

 

Figure 35: Menu Visibility - Edit Menu 

Screen Explanation 

 

Checkbox Function 

Edit Menu 

Cut Displays Cut menu 

Copy Displays Copy menu 

Paste Displays Paste menu 

Delete  Displays Delete menu 

Setting Displays Setting menu 

Change Password Displays Change Password menu 
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Window Menu – Customize Perspective (cont.) 

 

 

Figure 36: Menu Visibility – Watch Lists 

 

Screen Explanation 

 

Checkbox Function 

Watch Lists Displays Watch Lists menu 
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Window Menu – Customize Perspective (cont.) 

 

 

Figure 37: Menu Visibility – Trading Menu 

Screen Explanation 

 

Checkbox Function 

Trading Menu 

Orders Displays Orders menu 

Orders Summary Displays Orders Summary menu 

Trades Displays Trades menu 

Trades Summary Displays Trades Summary menu 

Buy Order Displays Buy Order menu 

Sell Order Displays Sell Order menu 

Modify Order Displays Modify Order menu 

Cancel Order Displays Cancel menu 

Fund Movement Displays Fund Movement menu 

Combined Margin View Displays Combined Margin View menu 

Margin Detail View Displays Margin Detail View menu 

Client Margin View Displays Client Margin View menu 

 

BMA Capital Management Limited



 Trading Terminal v2.0.2_15 2012 
 

 47 

 

Window Menu – Customize Perspective (cont.) 

 

 

Figure 38: Menu Visibility – View Menu 

Screen Explanation 

 

Checkbox Function 

Views Menu 

Spot Symbols Displays Spot Symbols menu 

Locked Symbols Displays Locked Symbols menu 

Announcements Displays Announcements menu 
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Window Menu – Customize Perspective (cont.) 

 

 

Figure 39: Menu Visibility – Reports Menu 

Screen Explanation 

 

Checkbox Function 

Reports Menu 

Integrated Ledger Displays Integrated Ledger report 
Customer Payment Displays Customer Payment report 
Net Share Custody Displays Net Share Custody report 
Outstanding Orders Displays Outstanding Orders report 
Periodic Summary Displays Periodic Summary report 
Periodic Detail Displays Periodic Detail report 
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Window Menu – Customize Perspective (cont.) 

 

 

Figure 40: Menu Visibility – Utilities Menu 

Screen Explanation 

 

Checkbox Function 

Utilities Menu 

Quote Request Displays Quote Request on menu as well as on right clicking the security 

Securities Displays Securities menu 

Market Summary Displays Market Summary menu 

Events Displays Events menu 

Currencies Displays Currencies menu 

Web Browser Displays Web Browser menu 

News Displays News menu 

 

 

 

 

BMA Capital Management Limited



 Trading Terminal v2.0.2_15 2012 
 

 50 

 

Window Menu – Customize Perspective (cont.) 

 

 

Figure 41: Menu Visibility – Window Menu 

Screen Explanation 

 

Checkbox Function 

Window Menu 

Open New Window Displays Open New Window menu 

Open Perspective Displays Open Perspective menu with open option as Chart, Research, 
Social, Banking and Trading. 

Customize Perspective Displays Customize Perspective menu 

Save Perspective As Displays Save Perspective As menu 

Reset Perspective Displays Reset Perspective menu 

Preferences Displays Preferences menu 
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Window Menu – Customize Perspective (cont.) 

 

 

Figure 42: Menu Visibility – Help Menu 

Screen Explanation 

 

Checkbox Function 

Help Menu 

Install New Software Displays Install New Software menu 

Check for Udpates Displays Check for updates menu 

About BMA Trading 
Terminal 

Displays About BMA Trading Terminal menu 

 

  

BMA Capital Management Limited



 Trading Terminal v2.0.2_15 2012 
 

 52 

 

1.7.4 Window Menu – Save Perspective As 
Navigation: 

Window – Save Perspective As 

Saves the perspective as the name specified. 

 

Figure 43: Save Perspective As 

 

Screen Explanation 

 

Field Function 

Name Name of the file to be saved. 
 

1.7.5 Window Menu – Reset Perspective 
Navigation: 

Window > Reset Perspective 

Resets the perspective to default 
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1.7.6 Window Menu – Preferences 
Navigation 

Window > Preferences 

Tree Hirarchie:  

 General 
o Currencies 
o Network 

o Perspectives 
o Startup and Shutdown 

 Appearance 

o Colors and Fonts 
 Charts 

o Default Values 
 Logging 

 News 
o RSS News  

 Notification Setting 

o KSE Announcement Setting 

o Locked Symbols 
o Orders and Trades 

 Plugin 

o   BMA Server 
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Window Menu – Preferences (cont.) 

 

General – Currencies 

Check the currencies from the checkboxes provided. 

 

Figure 44: Preferences – General - Currencies 

 

Screen Explanation 

 

Checkbox Function 

Update currencies when 
starting feed 

Check this checkbox when to update currencies when starting a feed 
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Window Menu – Preferences (cont.) 

 

General - Network 

 

Figure 45: Preferences –General - Network 

 

Screen Explanation 

 

Checkbox or Field Function 

Enable HTTP Proxy 
connection 

Check this checkbox if you are using a proxy server 

HTTP proxy host address Give IP address or hostname of the proxy server 
HTTP proxy host port Give port used for the proxy server 
Enable Authentication Check if your proxy server is using authentication 

User name Give proxy user name 

Password Give proxy user password 
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Window Menu – Preferences (cont.) 

 

General – Perspectives 

 

Figure 46: Preferences – General - Perspectives 

Screen Explanation 

 

Checkbox or Field Function 

Open a new perspective - 
open new perspective in 
the same window or in a 
new window 

To open new perspective in the same window or in a new window select 
appropriate radio button 

Fast View – Open a new 
view within the 
perspective or as a fast 
view 

Select appropriate radio button to open view within the perspective or as 
a fast view. 

Available perspectives You can select appropriate perspective to make default, reset or delete it. 
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Window Menu – Preferences (cont.) 

 

General – Startup and Shutdown 

 

Figure 47: Preferences – General – Startup and Shutdown 

Screen Explanation 

 

Checkbox  Function 

Update history data on 
startup 

Updates history data on startup 

Update new heads on 
startup 

Updates news headlines on startup 

Minimize to system tray Enables the option to minimize to system tray 

Refresh securities on 
startup 

Refreshes securities on startup 

Confirm exit when closing Prompts for confirmation of exit when closing terminal 
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Window Menu – Preferences (cont.) 

 

Appearance 

To change appearance or startup, select the appropriate item from the navigation tree and press 
edit. For example in the figure Announcements and Recently Added Item and background is 
selected. Select the color and press Apply button to apply changes. Press “Use System Font” to use 

system font. 

 
Figure 48: Preferences – Appearance – Colors and Fonts 
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Window Menu – Preferences (cont.) 

 

Charts – Default Values 

Specify appropriate time limit for data to be maintained. 

 

Figure 49: Preferences – Charts – Default Values 

 

Screen Explanation 

 

Checkbox  Function 

Initial backfill  Select appropriate time for initial backfill. By default it is last 5 years. 
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Window Menu – Preferences (cont.) 

 

Logging 

 

Figure 50: Preferences – Logging 

Screen Explanation 

 

Checkbox  or Field Function 

Write to console Writes the log to console 

Write to file Writes the log to default file. Format is default or extended 

Levels – General Logging levels are Off, Fatal, Error, Warn, Info, Debug and All. If All is 
selected all logging is enabled 

Levels  - Apache HttpClient Logging levels are same as General 
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Window Menu – Preferences (cont.) 

 

News 

 

Figure 51: Preferences – News 

Screen Explanation 

 

Checkbox  or Field Function 

Update on startup Updates news feed on startup 

Follow quote feed running 
status 

Keeps numbers feeds up to the number specified 

Provider Check RSS News provider 
 

News – RSS News 

Already explained in 1.6.7 i.e. Utilities Menu – News. 
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Window Menu – Preferences (cont.) 

 

Notification Setting – KSE Announcement Setting 

 

Figure 52: Preferences – Notification Setting – KSE Announcement Setting 

 

Screen Explanation 

 

Checkbox  or Field Function 

Sound Alert Setting – 
Enable KSE Announcement 

Plays a sound when KSE announcement is received 

Sound File Name Name of the sound file 

Notification Alert Setting – 
Enable KSE Announcement 

Enables KSE Announcement 

Notification Time KSE Announcement is updated in the number of seconds specified 

Block on open Blocks the Alert message when announcement is open 
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Window Menu – Preferences (cont.) 

 

Notification Setting – Locked Symbols 

 

Figure 53: Preferences – Notification setting – Locked Symbols 

Screen Explanation 

Checkbox  or Field Function 

Sound Alert Setting – 
Enable lock confirmation 

Plays a sound when a symbol(s) is/are locked 

Sound File Name Name of the sound file 

Notification Alert Setting – 
Enable lock confirmation 

Enables confirmation of locked symbol(s) 

Notification Time Locked symbol(s) confirmation is/are updated in the number of seconds 
specified 

Block on open Blocks the Alert message when locked confirmation is open 

Popup Dialog – Enable lock 
confirmation 

Opens a popup dialog on locked symbol(s) confirmation 

Add to events view Adds lock confirmation message to the events view 
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Window Menu – Preferences (cont.) 

Notification Setting - Orders and Trades 

 

Figure 54: Preferences – Notification Setting – Orders and Trades 

Screen Explanation 

Checkbox  or Field Function 

Sound Alert Setting – 
Enable order confirmation 

Plays a sound when an order is placed 

Sound File Name Name of the sound file 

Sound Alert Setting – 
Enable trade confirmation 

Plays a sound when a trade is executed 

Sound File Name Name of the sound file 

Notification Alert Setting – 
Enable order confirmation 

Enables confirmation of locked symbol(s) 

Notification Time Order confirmation is updated to the client in the number of seconds 
specified 

Block on open Blocks the Alert message when order confirmation is open 

Notification Alert Setting – 
Enable trade confirmation 

Enables confirmation of trade 

Notification Time Trade confirmation is updated to the client in the number of seconds 
specified 

Block on open Blocks the Alert message when trade confirmation is open 

Popup Dialog Setting – 
Enable order confirmation 

Opens a popup dialog when an order is confirmed 

Popup Dialog Setting – 
Enable trader confirmation 

Open a popup dialog when  a trade is confirmed 
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Window Menu – Preferences (cont.) 

 

Plugins – BMA Server 

 

Figure 55: Preferences – BMA Server 

 

Screen Explanation 

 

Checkbox  or Field Function 

User Id Specify user id to be saved every time terminal is restarted 

Password Specify password to be saved every time terminal is restarted 
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1.8 Help Menu  

1.8.1 Help Menu – Install New Software 
Navigation: 

Help > Install New Software 

Terminal provides a feature to update existing software from the terminal website. Install New 

Software is one time effort and is not required if it is already configured. 

In order to download software updates, you have to verify the Auto Update Server URL 

(http://www.serverurl.com/updatesite/) is configured in your software. At the place of serverurl 
give URL of the server where updates are available. 

Click on work “Work with the list of software sites”. 

 

Figure 56: Install New Software 
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Help Menu – Install New Software 

Following window appears. 

 

Figure 57: Add Software Site 

Click on “Add” button to add new software site or click on edit button to edit existing software site. 
Following window appears when you click on “Add” button. 

 

Figure 58: Install New Software 

Screen Explanation 

 

Checkbox  or Field Function 

Name Give name for the software site 

Location Give the location of the software site. 

BMA Capital Management Limited



 Trading Terminal v2.0.2_15 2012 
 

 68 

 

Help Menu – Install New Software 

 

Figure 59: Give Update Site Location 

After giving information press OK button. 

If a software site is updated, press reload button. It will check whether the software site is available. 

 

Figure 60: Reloading Software Site 
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Help Menu – Install New Software 

If software site is unavailable following error appears. 

 

Figure 61: Software Site Unavailable 

If there is a success message, you have configured the URL and you are ready to download the 

software updates. 
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1.8.2 Help Menu – Check for Updates 
Navigation: 

Help > Check for Updates 

If the updates will available then you will see the following view. 

 

Figure 62: Update Software 

Screen Explanation 

 

Checkbox  or Field Function 

Base Feature A terminal feature to be updated 

Charts Feature A terminal feature to be updated 

Ext View Feature A terminal feature to be updated 

News Feature A terminal feature to be updated 

Reports Feature A terminal feature to be updated 

Trading Feature A terminal feature to be updated 
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Help Menu – Check for Updates (cont.) 

Following window appears on pressing “Next” button. 

 

Figure 63: List of New Software Available 

Now your software starts downloading updates from server you have configured in previous step. 

 

Figure 64: Updating Software 

Note: Sometime it shows an error message while downloading the updates due to your internet 
connection speed but be patient and try it again (Check for updates) because ultimately it will 
download updates. 

After downloading updates it will show warning message. (Just ignore it) 
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Help Menu – Check for Updates (cont.) 

 

 

Figure 65: Warning – Unsigned Content 

 

Now your software is updated. You have to restart terminal in order to view changes. 

 

Figure 66: Restart Application 

 

After restarting the terminal, updates will be incorporated in your terminal. To verify it again check 

for updates, you will see the following message that no updates were found. 

 

 

Figure 67: No Updated Available 
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1.9 Charts Perspective 
Navigation: 

Open Perspective Button > Others > Charts Perspective 

Charts perspective is a complete perspective just like Trading Perspective. It enables user to view 

different statistics for analysis. Along with the plotting of graphs and charts, there are indicators 
tools and patterns available for analysis purpose. 

 

Figure 68: Open a Chart 

Chart will be displayed. This chart provides price statistics along with time. There is also a bar chart 
in the bottom that displays volume statistics along with time. 

You can change the type of the chart by selecting the line displayed in the line chart. Right click it 
and click properties. Following popup window appears. Select Type of chart as Line, Bars, Candles or 
Histogram Area. 
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Charts Perspective (cont.) 

 

Figure 69: Change Type of Chart 

You can also override the color theme by checking “Override color theme” and select color from the 

color palette for line bars or candles.  

 

Figure 70: Change Type of Chart 
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You can view the charts for certain time duration by selecting history chart or intraday chart from 

the top right of charts view as encircled in the figure 71. 

 

Figure 71: Change Type of Chart 

Screen Explanation 

 

Field Function 

All Shows complete history 

2 year Shows 2 year data 

1 year Shows 1 year data 

6 month Shows 6 month data 

1 month Shows 1 month data 

1 day Show intraday chart 
Show current price Shows current price in the chart 
Show Market Depth Show Market Depth in the chart 
Delete Chart Deletes the chart 
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1.9.1 Charts Perspective - Top Indicators 
Top Indicators provide different statistics as Bollinger Brands, Linear Regression, Moving Average, 

Trend Channel and Typical Price.  

 

Figure 72: Top Indicators 

To view a top indicator click on the indicator from the Charts Palette drag it and drop it onto the 

Chart view. Following window appears. In figure 72 and figure 73 Bollinger Brands is configured. 

 

Figure 73: Bollinger Brands - General 

 

BMA Capital Management Limited



 Trading Terminal v2.0.2_15 2012 
 

 77 

 

Charts Perspective – Top Indicators (cont.) 

Provide label in the label field. You can also check the “Override color theme” checkbox if you want 
to change the color of the chart. 

You can also change the indicators by clicking the indicators link from the tree.  

 

Figure 74: Bollinger Brands Indicators 

Screen Explanation 

 

Field Function 

Input Field Input field can be either Close, High, Low, Open or Volume. 
Period Select the period  

Upper Deviation Select upper deviation 

Lower Deviation Select  lower deviation 

MA Type Select MA Type 

Upper Line Style Select upper line style 

Middle Line Style Select middle like style 

Lower Line Style Select lower line style 
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Charts Perspective – Top Indicators (cont.) 

Following chart appears. 

 

Figure 75: Bollinger Brands Indicators 

Similarly other Top Indicators line Linear Regression, Moving Average, Trend Channel and Typical 
Price can be displayed.  
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1.9.2 Charts Perspective – Bottom Indicators 
Bottom Indicators can display different statistics as Chaikin A/D Line, Chaikin A/D Oscillator, A/D 

Movement Index, etc. 

 

Figure 76: Bottom Indicators 
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Charts Perspective – Bottom Indicators (cont.) 

To view a top indicator click on the indicator from the Charts Palette drag it and drop it onto the 

Chart view. Following window appears. In figure 77 and figure 78 Chaikin A/D Line is configured and 

displayed. 

 

Figure 77: Bottom Indicators 

Give the label and Style. Check “Orderride color theme” if you want to change color of the line, and 

press OK. Following chart appears. 

 

Figure 78: Bottom Indicators 

Similarly other Bottom Indicator can be displayed. 
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1.9.3 Charts Perspective – Tools 
FanLine, FIboArc, FiboLine and Line tools are available in the terminal. 

To draw a FanLine, drag FanLine from charts palette – tools and drop it onto Charts view. FanLine is 

displayed in the chart. 

 

Figure 79: FanLine 

To draw a FiboArc, drag FiboArc from charts palette – tools and drop it onto Charts view. FiboArc is 

displayed in the chart. 

 

Figure 80: FiboArc 
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Charts Perspective – Tools (cont.) 

To draw a FiboLine, drag FiboLine from charts palette – tools and drop it onto Charts view. FiboLine 

is displayed in the chart. 

 

Figure 81: FiboLine 

To draw a simple Line, drag Line from charts palette – tools and drop it onto Charts view. Line is 
displayed in the chart. 

 

Figure 82: FiboLine 
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1.9.4 Charts Perspective – Patterns  
Different Patterns can be displayed by dragging it and dropping it onto the Charts view. Following 

patterns are available. 

 

Figure 83: Patterns 
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Charts Perspective – Patterns (cont.) 

For example, for viewing Closing Price Reversal drag it and drop it onto the Charts view. It will be 

displayed as shown in figure 84. 

 

Figure 84: Patterns 

 

1.9.5 Charts Perspective – Others 
In others volume can be viewed. 

Figure 85: Volume 
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2 Transactional 
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2.1 Trading Menu 

2.1.1 Trading Menu – Orders 
Navigation: 

Trading > Orders or Ctrl+O (shortcut) 

All orders placed are available in the orders menu. All order are available in the All tab, where as 
Pending, Filled, Cancelled and Rejected orders are available in the corresponding tabs. 

 

Figure 86: Orders 

  

BMA Capital Management Limited



 Trading Terminal v2.0.2_15 2012
 

 87 

 

 

2.1.2 Trading Menu – Orders Summary 
Navigation: 

Trading > Orders Summary or Ctrl++Shift+O (shortcut)  

In orders summary all buy and sell orders placed are available along with the total and grand total 

of all buy and sell orders. 

 

Figure 87: Orders Summary 

 

Screen Explanation 

 

Checkbox  or Field Function 

Exchange Select name of the exchange 

Client Code Give Clint code of the client placing the order(s) 
Symbol Give Symbol for which order(s) is/are placed 

Sub Code Give Sub code of the order(s) 
Reference Number Give Reference number of the order(s) 
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2.1.3 Trading Menu – Trades 
Navigation: 

Trading - Trades or Ctrl+R (shortcut) 

All executed trades are available here. 

 

Figure 88: Trades 
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2.1.4 Trading Menu – Trades Summary 
Navigation: 

Trading > Trades Summary or Ctrl+Shift+R (shortcut) 

Summary of all executed trades is available here. A search feature is available to narrow down the 

search. 

Figure 89: Trades Summary 

Screen Explanation 

 

Checkbox  or Field Function 

Exchange Select name of the exchange 

Client Code Give Clint code of the client placing the order(s) 
Symbol Give Symbol for which order(s) has/have been placed 

Sub Code Give Sub code of the order(s) 
Reference Number Give Reference number of the order(s) 
From Date Give Starting time after which order has been placed 

To Date Give Ending time before which order has been placed 
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2.1.5 Trading Menu – Buy Order Form 
Navigation: 

Trading > Buy Order Form or F4 (shortcut) 

Buy order form is used to place a buy order. 

 

Figure 90: Buy Order Form 

 

Screen Explanation 

 

Checkbox  or Field Function 

Volume Give volume of the order 
Symbol Give symbol  
Price Give price for the symbol 
Client Code Give client code if trader is logged in. If client is logged in client code 

appears and is disabled. 
Sub Code Give sub code 

Order Type Give order type as LIMIT, STOP LOSS, MIT, S/L Market, Market or Short Sell 
Order Property Give order property as NONE or AON 

Reference Number Give reference number for the order 
Disc Volume Give disc volume 

Exchange Give exchange in which order is placed 

Market Give market whether REG, COT, FUT, PRV, ODL, NCCSF, NCDFUT 
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Trading Menu – Buy Order Form 

On pressing the button buy order confirmation screen appears. 

 

 

Figure 91: Order Confirmation Prompt 

Press OK button to place the order. 

Following notification appears when order is successfully placed. 

 

Figure 92: Order Confirmation 

Order starts appearing in the orders view. 
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2.1.6 Trading Menu – Sell Order Form 
Navigation: 

Trading > Sell Order or F5 (shortcut) 

Sell Order form is used to place a sell order. 

 

Figure 93: Sell Order Form 

Screen Explanation 

 

Checkbox  or Field Function 

Volume Give volume of the order 
Symbol Give symbol  
Price Give price for the symbol 
Client Code Give client code if trader is logged in. If client is logged in client code 

appears and is disabled. 
Sub Code Give sub code 

Order Type Give order type as LIMIT, STOP LOSS, MIT, S/L Market, Market or Short Sell 
Order Property Give order property as NONE or AON 

Reference Number Give reference number for the order 
Disc Volume Give disc volume 

Exchange Give exchange in which order is placed 

Market Give market whether REG, COT, FUT, PRV, ODL, NCCSF, NCDFUT 

 

Order confirmation prompt appears. 
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Trading Menu – Sell Order Form 

 

Figure 94: Order Confirmation Prompt 

Press OK button to place sell order.  

Following appears when the sell order has been successfully placed. 

 

Figure 95: Order Confirmation Prompt 

In the figure 77, Trade Confirmation message appears along with Order confirmation. Trade 

Confirmation message shows that a trade has been executed. 
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2.1.7 Trading Menu - Modify Order Form.(Coming.Soon) 
Navigation: 

Trading > Modify Order or F9 (shortcut) 

Modify Order Form is used to modify an order. 

 

Figure 96: Modify Order Form 

Screen Explanation 

Checkbox  or Field Function 

Volume Give volume of the order 
Symbol Give symbol  
Price Give price for the symbol 
Client Code Give client code if trader is logged in. If client is logged in client code 

appears and is disabled. 
Sub Code Give sub code 

Reference Number Give reference number for the order 
Disc Volume Give disc volume 

 

Modify confirmation prompt appears. 

 

Figure 97: Modify Confirmation Prompt 
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Trading Menu - Modify Order Form 

Modify confirmation message appears. 

 

Figure 98: Modify Confirmation 

If order gets rejected due to any reason the rejection message appears, as it is shown in the figure. 

 

2.1.8 Trading Menu – Cancel Order 
Navigation: 

Trading > Cancel Order 

Select the order from the orders view. Right click it and select cancel. You can also select cancel 
order from the Trading Menu after selecting order from the orders view. 

 

Figure 99: Cancel Order 

Order cancelation confirmation appears. 

 

Figure 100: Cancel Order Confirmation Prompt 
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Trading Menu – Cancel Order 

 

Figure 101: Cancel Order Confirmation 

If order cancellation of the order gets rejected due to any reason rejection message appears. 

 

Figure 102: Cancel Order Confirmation (order not cancelled) 
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2.1.9 Trade Menu – Fund Movement.(Coming.Soon) 
Navigation: 

Trade > Fund Movement 

Fund Movement allows transfer or withdrawal of funds. 

 

Figure 103: Fund Movement 

Screen Explanation 

ComboBox or Field Function 

Client Code Give client code. If client is logged in client code is automatically selected 
and this field is disabled. 

Transfer/Withdrawal Select Transfer the amount or select Withdrawal to withdraw an amount. 
From Select the exchange 

To Select the exchange 

Cash Amount Enter the amount to transfer or withdraw 

 

2.1.10 Trade Menu – Combined Margin View.(Coming.Soon) 
Navigation: 

Trading > Combined Margin View 

In Combined Margin View you can view Account Summary, Account Liquidity and Portfolio Details. 

Account Summary can be viewed in the form of exchange, cash balance, profit sold, portfolio value, 

profit/loss etc details. Whereas in Account Liquidity you can view the liquidity details in the form of 
margin, exposure, margin required, free margin percentage, cash withdrawal, cash withdrawal limit, 
cash margin call and net margin call etc details. In Portfolio Details you can view symbol, sellable 

holding, profit/loss, buy quantity, sell quantity, pending buy, pending sell, open volume, net holding 

volume, market price and net holding value. 
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Trade Menu – Combined Margin View 

 

Figure 104: Combined Margin View 

Screen Explanation 

 

Field Function 

Client Give the client code in case trader or admin is logged in. In case of client 
code is automatically picked and this field is disabled 

 

 

2.1.11 Trade Menu – Margin Detail View.(Coming.Soon) 
Navigation: 

Trading > Margin Detail View 

In Margin Detail view you can view the margin details in the form of account summary, account 

liquidity and portfolio details. 
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Trade Menu – Margin Detail View 

 

Figure 105: Margin Detail View 

Screen Explanation 

 

Field Function 

Client Give the client code in case trader or admin is logged in. In case of client 
code is automatically picked and this field is disabled 
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2.1.12 Trade Menu – Client Margin View 
Navigation: 

Trading > Client Margin View 

In Client Margin view user can view client margin in the form of cash balance, blocked and 

unblocked margin, custody, available margin, cfs, future, provisional and pending orders, exposure 

allowed, available percentage, and symbol details with custody, pending orders, cfs, future, 
provisional and available balance, blocked balance, market rate and value. 

 

Figure 106: Client Margin View 

 

Screen Explanation 

 

Field Function 

Client Code Give the client code in case trader or admin is logged in. In case of client 
code is automatically picked and this field is disabled 
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3 Reports  
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3.1 Reports Menu 

3.1.1 Reports Menu – Integrated Ledger.(Coming.Soon) 
Navigation: 

Reports > Integrated Ledger 

Integrated Ledger report displays the ledger in the form of trade voucher date, trade voucher 
number, trade type stock exchange, purchase, sale, trade currency, symbol, transaction rate, forex 

rate, rate, broker amount, levies, debit, credit, and current balance. In the end grand total of 
balance is displayed.  

 

Figure 107: Integrated Ledger Report 

 

Screen Explanation 

 

Field Function 

Client Code Give the client code in case trader or admin is logged in. In case of client 
code is automatically filled and this field is disabled 

From Date Narrows down the ledger search. Ledger with trade/vouch date after this 
date is displayed 

To Date Narrow down the ledger search. Ledger with trade/vouch date before this 
date is displayed 
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3.1.2 Reports Menu – Customer Payment 
Navigation: 

Reports > Customer Payment 

Customer Payment Requests report displays status of customer payment request(s). 

 

Figure 108: Payment Requests Report 

 

Screen Explanation 

 

Field Function 

Client Code Give the client code in case trader or admin is logged in. In case of client 
code is automatically filled and this field is disabled 

From Date Narrows down the search. Request(s) with request date after this date 
is/are displayed 
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3.1.3 Reports Menu – Net Share Custody 
Navigation: 

Reports > Net Share Custody 

Net Share Custody report displays net custody share for any specified symbol. 

 

Figure 109: Net Share Custody Report 

Screen Explanation 

 

Field Function 

Client Code Give the client code in case trader or admin is logged in. In case of client 
code is automatically filled and this field is disabled 

As on Date Net share custody on this date is displayed 

Symbol Symbol whose net share custody is to be displayed 
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3.1.4 Reports Menu – Outstanding Orders 
Navigation: 

Reports > Outstanding Orders 

Outstanding Orders report displays outstanding orders and their status. 

 

Figure 110: Outstanding Orders Report 

Screen Explanation 

 

Field Function 

Client Code Give the client code in case trader or admin is logged in. In case of client, 
client code is automatically filled and this field is disabled 

Exchange Select the exchange 

 

  

BMA Capital Management Limited

imac
BMA Capital



 Trading Terminal v2.0.2_15 2012 
 

 106 

 

3.1.5 Reports Menu – Periodic Summary 
Navigation: 

Reports > Periodic Summary 

Periodic Trade Summary shows symbol wise summary of client’s trades in a particular period of 

time. Report can be requested for a particular period of time and for a particular clearing type. It 

shows the summary of client’s trades in all symbols. 

 

Figure 111: Periodic Summary Report 

Screen Explanation 

 

Field Function 

Client Code Give the client code in case trader or admin is logged in. In case of client 
code is automatically filled and this field is disabled 

From Date Select starting date 

To Date Select ending date 

Exchange  Select exchange 

Clearing Type Select clearing type 
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3.1.6 Reports Menu – Periodic Detail 
Navigation: 

Reports > Periodic Detail 

Periodic Details report displays periodic details for a particular symbol. 

 

Figure 112: Periodic Detail Report 

Screen Explanation 

 

Field Function 

Client Code Give the client code in case trader or admin is logged in. In case of client 
code is automatically filled and this field is disabled 

From Date Select starting date 

To Date Select ending date 

Exchange  Select exchange 

Clearing Type Select clearing type 

Symbol Give a symbol for which periodic detail is to be displayed 
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